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1. Hướng dẫn cài đặt và sử dụng webmail 

    Người dùng muốn vào mailbox (hộp thư), có thể dùng trình duyệt Web ví dụ Internet Explorer, 

google chrome, Firefox… để vào Outlook Web Access: 

 Mở trình duyệt Web, sau đó nhập địa chỉ sau: https://mail.aits.vn    

 Sau khi nhập địa chỉ trên vào, trang WebMail sẽ mở ra, người dùng sẽ nhập tên đăng nhập 

và mật khẩu để chứng thực quyền sử dụng. 

  

 Có thể bạn sẽ được thông báo chọn ngôn ngữ và thời gian để trình duyệt Web hiển thị tốt 

nhất các thông tin email. Các hướng dẫn trong tài liệu này được soạn dựa trên ngôn ngữ 

được chọn là Tiếng Anh.   

 Giới thiệu giao diện 

 Các thư của người dùng sau khi nhận được sẽ nằm trong folder Inbox. 

 Các thư mà người dùng soạn nhưng gửi đi chưa được sẽ nằm trong Drafts. 

 Các thư do người dùng đã gửi đi sẽ được sao lưu một bản và được để trong Sent Items. 

 Các thư đã được xóa (xóa tạm thời) sẽ nằm trong Deleted Items. 
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 Hướng dẫn gửi/nhận Email  

 Đăng nhập vào Webmail của người dùng, sau đó chọn nút thư mới  

 Sau đó ta nhập các thông tin người nhận, tiêu đề và nội dung Email. Sau khi nhập xong ta 

chọn nút  để gửi email đi 

  

 Sau khi gửi email, ta có thể kiểm tra xem email đã được gửi đi hay chưa trong mục Sent 

Item.  

  

Bấm Gửi để gửi mail đi 
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 Hướng dẫn sử dụng Lịch biểu - Calendar 

Chức năng Calendar trên Webmail giúp người dùng lên kế hoạch và sắp xếp thời gian cho công 

việc, nhắc nhở người dùng hoàn thành công việc theo lịch đã sắp xếp trong Calendar. 

Trên thanh bên bên phải, người dùng có thể sử dụng chức năng Calendar. 

Để tạo ra một Lịch biểu công việc, người dùng chỉ việc chọn công cụ là . Sau đó click 

, điền các thông tin cần thiết vào lịch rồi . 
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 Hướng dẫn sử dụng Contact 

Chức năng Contacts là nơi cho người dùng tạo ra và lưu lại thông tin liên lạc của mọi người. 

 Hướng dẫn Contact 

Để tạo một danh thiếp, người dùng chọn mục  sau đó click rồi điền đầy đủ các 

thông cần thiết. Sau đó click . 

 
 

 Hướng dẫn thay đổi ảnh đại diện 

Hệ thống Exchange 2016 có thêm tính năng mới là người dùng có thể add thêm ảnh đại diện (ảnh 

avatar) cho tài khoản Email của mình. Để thêm ảnh đại diện, người dùng chọn mục , sau đó 

click  
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Tiếp theo, người dùng chọn , chọn file định dạng ảnh (*.jpg; *.gif,…). Sau cùng 

chọn  

 
 

 Hướng dẫn sử dụng Tasks 

 Chức năng Tasks (Simple List) tạo ra những nhiệm vụ làm việc. Trong đó ta có thể hoạch 

định ngày bắt đầu công việc và ngày kết thúc công việc. Chức năng Tasks này còn có thể 

nhắc nhở người dùng sắp đến ngày hết hạn cho công việc đã đề ra. 

 Để tạo ra một nhiệm vu (Task), người dùng chọn mục trên thanh công cụ, sau đó 

click vào  rồi điền các thông tin cần thiết. Click  để lưu lại các task 

nhiệm vụ.  
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 Hướng dẫn sử dụng Tùy chọn -Option 

Out of Office Assistant: Khi người dùng đi công tác xa hay nghỉ phép không có mặt trong Ngân 

hàng, không thể nhận mail được thì người dùng nên dùng chức năng này. Chức năng này sẽ giúp 

người nhận tự động gửi thư ngược lại cho người gửi biết là mình không có mặt ở TCT HKVN làm 

việc với nội dung được viết dưới khung bên dưới sau khi chọn chức năng Automatic Replies. Sau 

đó click  để lưu lại cấu hình cho người dùng. 
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 Hướng dẫn sử dụng chữ ký cho Email  

 Trong phần này, người dùng có thể cấu hình tuỳ biến giao diện và tài khoản của mình như 

có bao nhiêu thư được thể hiện trong một trang, thông báo cho người dùng biết là mình có 

mail mới, tạo ra chữ ký ở cuối thư khi gửi thư cho mọi người. 

 Để tao ra chữ ký, người dùng click vào Options -> Mail -> Layout -> Email signature rồi 

nhập những thông tin của chữ ký. Để add thêm logo cho chữ ký, trên phần chữ ký, người 

dùng đặt con chỏ vào vị trí cần add và chọn  và sau đó click  để lưu lại cấu 

hình. 

Định thời gian tự trả lời bắt 

đầu khi nào và lúc nào kết 

thúc 
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 Hướng dẫn thay đổi ngôn ngữ 

 Người dùng có thể thay đổi ngôn ngữ trong giao diện Webmail từ Tiếng việt sang Tiếng anh 

(English), ta vào Options>General>Region and time zone.  
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 Hướng dẫn thay đổi Mật khẩu  

 Người dùng đăng nhập vào hệ thống mail qua Web mail. Tại giao diện sau khi đăng nhập, 

chọn biểu tượng Options>General>My account>Change your password 

 
 

 Màn hình Change your password xuất hiện, nhập mật khẩu cũ và mật khẩu mới 2 lần, Mật 

khẩu mới phải theo Quy định đã được ban hành, click  để thay đổi mật khẩu. 

 
 

 

Nhập password cũ 

Nhập Password mới 

Nhập lại Password mới 
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2. Hướng dẫn sử dụng email AITS lên ứng dụng Microsoft Outlook 

a. Các thư mục Microsoft Outlook 

Các thư mục xuất hiện ở bên trái của hộp thư của bạn, bên dưới địa chỉ thư điện tử của bạn (nó 

cũng được gọi là Navigation Pane). Hiện có hai loại thư mục: 

 Thư mục mặc định 

Các thư mục mặc định là thư mục tiêu hợp lý phần mềm MS Outlook của bạn. Các thư mục 

mặc định gồm có Drafts, Sent mail, Deleted Items, Trash, gửi tin rác và vân vân. Một số 

phiên bản của Outlook cũng có một thư mục Clutter, mặc dù nó sắp bị loại bỏ. 

 Thư mục cá nhân 

Đây là những thư mục bổ sung mà bạn tạo ra để cho những thư ưu tiên của bạn. Rất quan 

trọng để cẩn thận k ko tạo ra quá nhiều các thư mục hoặc bạn đủ sức bị lẫn lộn vì k biết thư 

mục nào để dùng. 

ví dụ về mỗi loại thư mục, xem phiên bản dành cho máy tính để bàn của hộp thư MS Outlook dưới 

đây: 

 

b. Sử dụng thư mục trong Outlook 

Các thư mục trong Outlook khá easy dùng nếu bạn biết phải làm gì. Dưới đây là một số 

những điều cơ bản để sử dụng các thư mục: 

 Tạo một thư mục mới New Folder 

Để tạo ra một thư mục trong MS Outlook, click vào tab Folder từ thanh Ribbon. Sau đó nhấp vào 

biểu tượng thư mục mới New Folder. Hộp thoại tạo thư mục mới Create New Folder sẽ hiển thị: 
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sử dụng hộp thoại tạo thư mục mới Create New Folder để thêm thư mục và giữ cho email của bạn 

có tổ chức. 

Nhập tên của thư mục mới vào trường Name. Nhấp chuột vào thư mục mà bạn mong muốn đặt thư 

mục mới và nhấp vào OK khi bạn đã thực hiện xong. 

Trong ví dụ này, tôi vừa mới xây dựng một thư mục có tên là Memos và đặt nó dưới thư mục From 

My Boss. Dưới đây là phương thức sắp xếp các thư mục hiện tại: 

 

Bạn có thể thêm một thư mục phụ bên dưới một thư mục sẵn có. 

 Đổi tên một thư mục 
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Bạn đủ sức refresh tên của thư mục đó sau khi bạn đã tạo ra nó. lựa chọn thư mục bạn muốn đổi tên 

bằng phương thức nhấp chuột vào nó. Nhấp vào biểu tượng đổi tên thư mục Rename Folder trong 

tab Folder. Bạn sẽ nhận thấy một hộp xuất hiện chung quanh tên thư mục đó: 

 

dùng biểu tượng Rename Folder để đổi tên một thư mục sẵn có trong MS Outlook. 

Gõ vào tên thư mục mới vào hộp thư. Khi bạn đang thực hiện xong, click phím Enter trên bàn 

phím của bạn. Tên thư mục mới của bạn sẽ được lưu lại. 

 Di chuyển một lá thư vào một thư mục 

Một khi bạn đã tạo ra một số thư mục, bạn đã sẵn sàng để khởi đầu đưa những lá thư vào đó. Quay 

trở lại hộp thư chính của bạn để nhìn thấy các lá thư của bạn: 
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Dưới đây là cách thức tổ chức thư trong Outlook bằng cách di chuyển các lá thư vào các thư mục. 

Nhấp vào một lá thư để chọn nó và chỉ không khó khăn dẫn lá thư đó vào thư mục chọn của bạn. 

Trong ví dụ dưới đây, tôi đang kéo tin nhắn hộp thư online “Project estimates” vào thư mục 

Memos: 

 

giống như bạn thấy, lá thư “Project estimates” hiện giờ đã ở trong thư mục Memos 

 

 

 Xóa một thư mục 

đôi khi bạn đủ nội lực thấy rằng bạn k còn mong muốn sư dụng một thư mục mà bạn vừa mới tạo. 

Khi điều này xảy ra, bạn có thể đơn giản xoá thư mục đó đi. 

Nhấp vào thư mục mà bạn mong muốn xóa trong bảng điều hướng Navigation (bên trái) 

để chọn nó: 
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Dưới đây là phương thức tổ chức các hộp thư email Outlook của bạn bằng cách xoá các thư 

mục không cần kíp. 

Nhấp vào biểu tượng Delete trong Ribbon. (Trông như dấu X.) Thư mục đó sẽ bị xoá. 

Chú ý: Nếu bạn xoá một thư mục, bất kỳ lá thư nào trong thư mục đó cũng sẽ bị xóa. 

c. Cách sử dụng categorize 

 Đổi tên hạng mục 

Theo mặc định, các hạng mục đó được đặt tên theo màu sắc. Để đổi tên một hạng mục, nhấp chuột 

vào mũi tên hướng xuống ở bên phải của biểu tượng Categorize. Từ trình đơn thả xuống lựa 

chọn all Categories. Hộp điều khiển Color Categories sẽ xuất hiện: 
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Bạn có thể làm mã màu cho những thư của bạn trong Outlook để đơn vị chúng. 

Đặt một dấu tích cạnh màu mà bạn mong muốn đổi tên và bấm vào nút Rename. Gõ đè lên tên mặc 

định của hạng mục để đổi tên. Nhấp vào nút OK khi bạn đang thực hiện xong các hạng mục đó. 

Dưới đây là một gợi ý về một số hạng mục vừa mới được đổi tên: 

 

Đặt tên cho mỗi hạng mục màu để đơn vị hộp thư Outlook của bạn 

Các hạnh mục tùy chỉnh riêng của bạn đủ sức không giống nhau. 

 Xóa một hạng mục 

Sau khi bạn đang tùy chỉnh tất cả các hạng mục của bạn, bạn có thể thấy rằng bạn sẽ k sử dụng tất 

cả các hạng mục này. Nếu điều đó xảy ra, bạn đủ nội lực xoá các hạng mục không dùng. 

Để xoá một hạng mục, bấm vào tùy chọn tất cả Categories trong trình đơn Categories thả xuống 

loại. Hộp thoại all Categories mở ra: 

 

Bạn đủ sức xoá các hình thức màu của Outlook mà bạn k dùng. 
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Nhấp vào hộp đánh dấu bên cạnh các màu sắc mà bạn muốn xóa. Trong ví dụ trên, tôi vừa mới xóa 

hạng mục màu cam vì tôi không dùng nó. Nhấp vào nút Delete . 

Khi một lời nhắc xuất hiện yêu cầu bạn công nhận xóa, click nút Yes. Khi bạn đang hoàn tất 

các thay đổi cho các hạng mục đó, nhấp vào OK. hình thức màu cam k còn xuất hiện trên trình 

đơn Categorize thả xuống và bạn k thể gán nó vào một thư tin nhắn hộp thư online. 

 Gán một hình thức màu cho một thư 

Một khi bạn vừa mới một mình hoá các thể loại màu của bạn, bạn đã sẵn sàng để bắt đầu gán chúng 

cho các thư trong hộp thư của bạn. Để gán một hình thức màu cho một lá thư, bấm vào lá thư đó 

để lựa chọn nó. Nhấp vào biểu tượng Categorize. Trình đơn Categorize thả xuống sẽ hiển thị: 

 

sử dụng trình đơn Categorize thả xuống để gán các hình thức màu cho email và đơn vị các hộp thư 

của bạn. 

Nhấp vào thể loại màu mà bạn muốn gán cho lá thư đang chọn. thể loại màu đó sẽ được gán cho 

thư. Bạn sẽ thấy màu sắc của hình thức màu là một hình vuông ở bên phải tên người send thư trong 

hộp thư của bạn. Trong bài viết của lá thư đó, nó xuất hiện bên dưới tên người gửi. 

Dưới đây là một gợi ý của một hộp thư với các hình thức màu gán cho all các tin nhắn: 
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Với các thể loại màu được gán cho các lá thư của bạn, bạn có thể biết ngay được phải làm gì với 

mỗi email. 

Một lá thư có thể có nhiều hơn một thể loại màu để gán vào. Để gán một hình thức màu phù 

hợp cho một lá thư, chọn lá thư đó và bấm vào một thể loại màu khác trong trình 

đơn Categorize thả xuống . 

 Loại bỏ categorize 

Theo thời gian, các hình thức màu của một lá thư đủ sức cải thiện. Bạn có hình thức bỏ một hình 

thức màu từ một lá thư hoặc cải thiện nó. Dưới đây là những điều cần sử dụng. 

Để loại bỏ một thể loại màu từ một lá thư, nhấn vào lá thư trong hộp thư của bạn để chọn nó. Nhấp 

vào biểu tượng Categorize. Từ trình đơn thả xuống, nhấp vào hình thức màu mà hiện vừa mới gán 

cho thư điện tử để loại bỏ nó: 
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Bạn có thể xoá một thể loại màu được chỉ định từ một tin nhắn hộp thư online. 

Bạn có thể gán một hình thức màu mới cho thư từ trình đơn thả xuống Categorize hoặc không gán 

màu cho nó. 

Để loại bỏ all các hình thức màu cùng một lúc từ một thư thư điện tử có nhiều hơn một hình 

thức màu, chọn thư đó và bấm vào tùy chọn Clear tất cả Categories từ trình đơn thả 

xuống Categorize: 

 

sử dụng tùy chọn Clear tất cả Categories để loại bỏ all các thể loại màu từ một email với 

nhiều hình thức màu được gán. 

d. Cách thực hiện Archive hoặc Delete những thư cũ và dọn dẹp 
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 Delete các email cũ không sử dụng 

Nó rất dễ dàng để xóa một tin nhắn hộp thư online cũ. Chỉ cần dễ dàng nhấp vào thư điện 

tử đó để chọn nó: 

 

Đây là cách thức đơn vị các hộp thư email Outlook của bạn bằng phương thức xóa các thư cũ. 

Nhấp vào biểu tượng Delete ở thanh Ribbon (nó trông giống như dấu X). Lá thư đó được chuyển 

tới thư mục Deleted Items. 

Để xoá vĩnh viễn một lá thư tin nhắn hộp thư online của bạn, bấm vào thư mục Deleted 

Items để xây dựng nó ra. (Nó nằm trong Navigation Pane ở bên trái và trông giống như một thùng 

rác). click vào lá thư đó một lần nữa để chọn nó. Nhấp vào biểu tượng Delete để xoá vĩnh viễn lá 

thư vừa mới lựa chọn. 

Chú ý: Một số sms bị xóa trọn đời đủ nội lực được phục hồi từ các máy chủ nếu chúng luôn 

luôn còn trong thư mục Deleted Items, nhưng bạn đủ nội lực sẽ k thể phục hồi các email sau khi 

bạn xóa bỏ nó. 

 Archive thủ công 

Một cách thức ít thông dụng hơn để di dời các thư điện tử cũ từ hộp thư của bạn là lưu trữ chúng. 

Để lưu trữ một thư điện tử, nhấn vào lá thư để chọn nó. Nhấp vào biểu tượng Archive trong thanh 

ribbon bên cạnh biểu tượng Delete: 
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sử dụng biểu tượng Archive là một phương thức khác để giữ cho các lá thư cũ có trật tự trong hộp 

thư đến của bạn. 

Nếu bạn không dùng chức năng Archive của Outlook trước đây, thì bạn sẽ được nhắc để tạo một 

thư mục lưu trữ. Nhấp vào nút Create archive folder. Outlook sẽ tạo ra một thư mục mới có tên 

Archive và chuyển các thư điện tử mà bạn đang lựa chọn vào đó: 

 

Lưu trữ những thư điện tử cũ trong thư mục Archive để tổ chức hộp thư của bạn. 

Trong tương lai khi bạn lưu trữ một thư điện tử, nó sẽ đi vào thư mục này. 
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 Archive tự động 

Bạn cũng có thể refresh setup lưu trữ tự động của MS Outlook. nhấn vào File > Options để mở cửa 

sổ Outlook Options: 

 

Bạn đủ sức thiết lập Outlook để auto lưu trữ các tin nhắn. 

Nhấp vào tùy chọn Advanced từ Navigation pane bên trái. Sau đó nhấp vào nút AutoArchive 

Settings. Hộp thoại AutoArchive sẽ xuất hiện: 
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sử dụng hộp thoại AutoArchive để xác định các thông số lưu trữ trong Outlook. 

dùng hộp đánh dấu để chọn các tùy chọn lưu trữ mà bạn mong muốn lựa chọn. Nhấp vào OK trên 

hộp thoại AutoArchive khi bạn vừa mới thực hiện xong. Sau đó nhấp vào OK trên cửa sổ Outlook 

Options. 

 


